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1. Definitions 
 
1.1 Unless the context otherwise requires, expressions not defined in this Allotment 

Document, but defined in the Act or the Rules shall have the meaning assigned 

thereto in the Act or the Rules, as the case may be. 

1.1.1. “Acceptable Bank” shall mean a Scheduled Bank as listed in the Second Schedule of 

the Reserve Bank of India Act, 1934 excluding those listed under the headings of 

Gramin Banks, Urban Co-operative Banks and State Co-operative Banks.  

1.1.2. “Act” shall mean the Coal Mines (Special Provisions) Act, 2015. 

1.1.3. “Allotment” means Allotment of identified coal mines to Government company or 

corporation of a State under provisions of Rule 11 (1) of the Rules. 

1.1.4. “Allottee” shall have the meaning ascribed thereto in Clause 3.4.2(iv). 

1.1.5. “Allotment Agreement” means the Agreement to be executed between the 

Nominated Authority and Allottee in substantially the same format as provided at 

Annexure V. 

1.1.6. “Allotment Document” shall mean this document and its Annexures including 

specifically the Allotment Agreement, the Mine Dossier, Office Memorandum 

number F.No.12012/01/2015-CA-III dated January 08, 2016 of Ministry of Coal, any 

addenda to this Allotment Document and any other document issued pursuant 

hereto.  

1.1.7. “Allotment Order” shall mean the allotment order issued under Section 5 of the Act. 

1.1.8. “Allotment Tranche” shall refer to the allotment of 1  identified coal mines 

earmarked for the purpose of sale of coal by Order No. CBA2-13011/5/2019-CBA2 

dated August 1, 2019, as amended, issued by the Central Government.  

1.1.9. “Applicable Law” shall mean all applicable statutes, laws, by-laws, rules, 

regulations, orders, ordinances, protocols, codes, guidelines, policies, notices, 

directions, judgments, decrees or other requirements or official directive of any 

governmental authority or court or other law, rule or regulation approval from the 

relevant governmental authority, government resolution, directive, or other 

government restriction or any similar form of decision, or determination, or any 

interpretation or adjudication having the force of law in India. 
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1.1.10. “Applicant” shall mean a Government Company or corporation that participates in 

the Allotment process by submitting the Application for the Coal Mine. 

1.1.11.  “Application” shall mean the application submitted by an Applicant pursuant to 

this Allotment Document on the electronic platform of MSTC and shall include the 

Affidavit and the Power of Attorney required to be submitted physically to the 

Nominated Authority. 

1.1.12. “Authorised Signatory” shall mean the individual representing an Applicant who 

has been duly authorised on behalf of such Applicant to execute and submit the 

Application in accordance with the terms hereof.  

1.1.13. “CIL Notified Price” shall mean the prevailing notified price of relevant grade(s) of 

coal by Coal India Limited or any of its subsidiaries, as may be territorially relevant 

to the Coal Mine. 

1.1.14. “Coal Mine” means a Schedule I coal mine referred in Annexure VI. 

1.1.15. “Eligibility Conditions” shall mean the eligibility conditions specified in the Act and 

the Rules including all the eligibility conditions listed in Clause 3.2.  

1.1.16. “Fixed Amount” shall have the meaning ascribed thereto in Clause 3.4.3(b).  

1.1.17. “Government Company” shall have the same meaning as assigned to it in clause (45) 

of section 2 of the Companies Act, 2013. 

1.1.18. “Host State” means the State where the Coal Mine is situated. 

1.1.19.  “Last Date” shall mean the date on which the Application is required to be 

submitted in accordance with Clause 3.6.1. 

1.1.20. “Mine Dossier” shall have the meaning ascribed thereto in the Rules. 

1.1.21. “Mine Plan” shall mean a mining plan which has been approved in accordance with 

the Applicable Laws in relation to the Coal Mine. 

1.1.22. “MSME” means a micro enterprise, or a small enterprise or a medium enterprise as 

defined in Micro, Small and Medium Enterprises Development Act, 2006, as 

amended from time to time. 

1.1.23. “MSME Share” shall mean 25% of the coal production from the Coal Mine on Run-

of-Mine (RoM) basis, in a calendar quarter and a financial year, and the same shall 
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include any amendments made to the same by the Central Government in its sole 

discretion.  

1.1.24. “MSTC” shall mean MSTC Limited (a Government of India undertaking). 

1.1.25. “Nominated Authority” shall mean the Nominated Authority appointed under 

section 6 (1) of the Act and the Rules framed there under. 

1.1.26. “Performance Security” shall have the meaning ascribed thereto in Clause 7. 

1.1.27. “Person” shall include any company or association or body of individuals, whether 

incorporated or not. 

1.1.28. “Preferred Applicant” shall have the meaning ascribed thereto in (a) Clause 6.1.1 – in 

case where only one Application is considered to be in compliance with all the 

Eligibility Conditions and is responsive pursuant to Clause 3.5; or (b) Clause 6.1.2– in 

case where more than one Application is considered to be in compliance with all the 

Eligibility Conditions and is responsive pursuant to Clause 3.5; 

1.1.29.  “Prior Allottee” shall have the meaning ascribed thereto in the Act and for the 

purposes of the Coal Mine, the Prior Allottee shall be as specified against each Coal 

Mine in Annexure VI.  

1.1.30. “Reserve Price” shall have the meaning ascribed thereto in Clause 3.8.1. 

1.1.31. “Rule 8(2) Order” shall mean an order issued by the Central Government under Rule 

8(2) of the Rules. 

1.1.32. “Rules” shall mean the Coal Mines (Special Provisions) Rules, 2014 or any other rules 

framed pursuant to the Act. 

1.1.33.  “Supreme Court Judgment” shall have the meaning ascribed thereto in Clause 2.1.1. 

1.1.34.  “Upfront Amount” shall have the meaning ascribed thereto in Clause 3.7.  
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2. Introduction 

2.1. Background 

2.1.1. The Supreme Court of India through its judgment dated August 25, 2014 read with 

its order dated September 24, 2014 (collectively the “Supreme Court Judgment”) had 

cancelled allotment of 204 coal blocks. The Coal Mine was included in the list of such 

204 coal blocks and accordingly, its allotment to the Prior Allottee was cancelled 

pursuant to the Supreme Court Judgment, with effect from the „appointed date‟ (as 

defined in the Act). 

2.1.2. Subsequent to the Supreme Court Judgment, the Coal Mines (Special Provisions) 

Ordinance, 2014; the Coal Mines (Special Provisions) Second Ordinance, 2014 were 

promulgated,  the Rules were framed; and the Act was passed for auction and 

allotment of all blocks which suffered cancellation pursuant to Supreme Court 

Judgment.  

2.1.3. In exercise of the powers conferred by Section 6 (1) of the Act, the Government of 

India (the “Central Government” or “GoI”) has appointed the Nominated Authority 

to allocate Schedule I coal mines as defined in the Act. In terms of Section 6(3) of the 

Act, the Central Government is required to act through the Nominated Authority for 

conduct of the allotment process. 

2.1.4. The Central Government has also issued a „Rule 8(2) Order‟ dated August 1, 2019, as 

amended, to the Nominated Authority for allotment of the Coal Mine pursuant to 

Section 5 (1) of the Act. A copy of such Rule 8(2) Order is available at: 

http://coal.nic.in.  

2.1.5. Accordingly, this Allotment Document is being issued by the Central Government 

through the Nominated Authority for Allotment of the Coal Mine. 

2.2. The Act and the Rules 

2.2.1. Applicants are encouraged to familiarise themselves with the Act and the Rules. As 

of the date of this Allotment Document, the Act and the Rules are available at: 

http://coal.nic.in. 

2.3. The Coal Mine 

2.3.1. The Coal Mine is being allotted strictly for the purpose of sale of coal as mentioned in 

the Rule 8(2) Order.  

http://coal.nic.in/
http://coal.nic.in/
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2.3.2. The mining operations are required to be conducted strictly in accordance with all 

Applicable Law, including without limitation the Act, the Rules, the Allotment Order 

and this Allotment Document and any document referred herein, including the 

Allotment Agreement. 
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3. Allotment Process 

3.1. Allotment Document 

3.1.1. The Notice Inviting Application (the “NIA”), Office Memorandum number 

F.No.12012/01/2015-CA-III dated January 08, 2016 of Ministry of Coal, the Allotment 

Agreement for the Coal Mine and the Mine Dossier shall be deemed to be a part of 

this Allotment Document. Subject to the provisions of Clause 4.10, the aforesaid 

documents and any addenda, corrigendum issued subsequent to this Allotment 

Document, will be deemed to form a part of the Allotment Document.  

3.1.2. The Applicants are required to register themselves on MSTC‟s website 

http://www.mstcecommerce.com to generate login ID and password. The Allotment 

Document for the Coal Mine can be downloaded from MSTC‟s website using the 

login ID and password. Allotment Document shall be available free of cost to each 

Applicant. 

3.1.3. The Applicants are required to examine all instructions, forms, terms, conditions, and 

other information contained or referred to in the Allotment Document. Failure to 

furnish all information required as per the Allotment Document or submission of an 

Application not substantially responsive to the Allotment Document in every respect 

will be at the Applicant‟s risk and may result in rejection of its Application. 

3.1.4. The Allotment Document is meant for the exclusive purpose of submitting an 

Application by the Applicant and shall not be transferred, reproduced or otherwise 

used for purposes other than for which it is specifically issued. 

3.1.5. At any time prior to the deadline for submission of Application, the Nominated 

Authority may, for any reason, whether at its own initiative, or in response to a 

clarification requested by a prospective Applicant, amend the Allotment Document. 

In order to afford prospective Applicants reasonable time in which to take the 

amendment into account in preparing their Application, the Nominated Authority 

may, at its discretion, extend the deadline for the submission of Application. 

3.2. Eligibility Requirement for Applicants 

3.2.1. Section 5(1) of the Act prescribes eligibility for allotment of Schedule I coal mines (as 

defined in the Act), which includes the Coal Mine. Applicants are required to ensure 

that they meet the conditions as mentioned in Section 5(1) of the Act and the 

additional eligibility conditions as listed in Clause 3.2.2 below:  

3.2.2. The Applicant must be:  

http://www.mstcecommerce.com/
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(i) a Government company or corporation or to a joint venture between two or 

more Government companies or corporations . Such Applicant shall also meet 

the conditions specified in Clause 3.2.2(ii) below: 

(ii) the Applicant should be either: (a) incorporated for the purpose of mining; or 

(b) should be engaged in mining activities or (c) should carry a letter of 

recommendation for allotment addressed to the Nominated Authority from 

their respective State Government in case the applicant is a State PSU or from 

the Central Government in case the applicant is a Central PSU. 

With respect to the above, it is clarified that: 

(a) the conditions prescribed in second, third and fourth proviso of 

Section 5(1) of the Act are continuous requirements and should be 

complied with at all times; 

(b) the expressions Government company has been defined in Section 

3(1)(i) of the Act which refers to section 2(45) of the Companies Act, 

2013; and 

(c) The expression associate company and subsidiary would have the 

same meaning as assigned to them in Sections 2(6) and 2(87), 

respectively, of the Companies Act, 2013. 

3.3. Digital Application 

3.3.1. Application(s) can only be submitted digitally on the electronic platform created by 

MSTC and no physical applications shall be accepted or considered. The 

Application(s) are required to be submitted on the website of MSTC in accordance 

with the instructions provided in Clause 5 (Instructions for Electronic Application). 

3.3.2. In case of any technical clarification regarding access to the electronic platform or 

conduct of the allotment process, the Applicants may contact MSTC directly at the 

address provided in Clause Error! Reference source not found.. 

3.4. Description of Application Process 

3.4.1. The Allotment would be conducted in the manner specified in the Act, Rules, and 

any other order issued by the Central Government in this regard.  

3.4.2. The allotment process would comprise of the following steps: 
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i. The Applicants would be required to submit duly completed Applications on the 

electronic platform of MSTC in the manner specified in Clause 5 (Instructions for 

Electronic Application); 

ii. The duly completed Applications shall be opened and evaluated by the 

Nominated Authority for compliance with the Eligibility Conditions and shall be 

tested for responsiveness pursuant to Clause 3.5; 

iii. Applicant selected on the basis of norms specified in Clause 6 shall be 

recommended as the “Preferred Applicant” for the Coal Mine.  

iv. Pursuant to Rule 11(8) of the Rules, the Nominated Authority shall recommend 

the name of the Preferred Applicant to the Central Government. Upon receipt of 

a direction from the Central Government that an Allotment Order should be 

issued to the Preferred Applicant, the Preferred Applicant shall be declared as 

the “Allottee”. 

v. Notwithstanding the above, in the event that the Nominated Authority or the 

Central Government determines that a Preferred Applicant should not be 

declared the Allottee on account of any reason whatsoever, including without 

limitation the withdrawal of the Preferred Applicant from the allotment process 

for the Coal Mine or the Preferred Applicant ceasing to comply with the 

Eligibility Conditions, then the Coal Mine may be allotted to Applicant second in 

the preference order. 

vi. Upon receiving the direction from Central Government, the Nominated 

Authority shall inform the Allottee and execute the Allotment Agreement. The 

Allottee shall not be entitled to seek any deviation, modification or amendment 

in the Allotment Agreement, except with the prior approval of the Central 

Government. 

3.4.3. Subsequent to signing of the Allotment Agreement the Allottee shall, within such 

period as prescribed in Clause 3.6: 

(a) furnish the Performance Security as specified in Clause 7 and having 

provided such undertaking as specified in Allotment AgreementError! 

Reference source not found., in case the approved Mining Plan is not 

available; 

(b) pay a fixed amount for the value of Land and Mine Infrastructure; cost of 

preparation of geological report borne by the Prior Allottee; cost incurred by 

CMPDIL and other Government agencies in deriving detailed geological 
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boundary coordinates and in preparing geological report and mining plan (as 

applicable); cost of obtaining all statutory licenses, permits, permissions, 

approvals, clearances or consents relevant to the mining operations, borne by 

the Prior Allottee (collectively the “Fixed Amount”). If the Allottee is a Prior 

Allottee, then, the compensation payable to such Allottee shall be set off or 

adjusted against the Fixed Amount payable by such Allottee. The Fixed 

Amount is required to be deposited by the Allottee with the Nominated 

Authority in accordance with the relevant provisions of the Act and the 

Rules. The Fixed Amount based on the available information and the 

assessment made by the competent authority will be uploaded as a part of the 

Allotment Document/ Mine Dossier. Any upward revision in the Fixed 

Amount on a subsequent date by the Government or the Nominated 

Authority consequent upon any process or on the orders of any competent 

court of law, shall also be payable by the Allottee. 

(c) pay the first instalment of the Upfront Amount as mentioned in Annexure VI 

against the Coal Mine and provide such undertaking to pay Upfront Amount 

as specified in Allotment Agreement in case the approved Mining Plan is not 

available. 

3.4.4. Upon receipt of Performance Security and other payments mentioned in Clause 3.4.3 

above, the Allotment Order shall be issued, in duplicate, by the Nominated Authority 

to the Allottee and the Allottee shall, within 7 (seven) days of the receipt of the 

Allotment Order, sign and return the duplicate copy of the Allotment Order in 

acknowledgement thereof. In the event the duplicate copy of the Allotment Order 

duly signed by the Allottee is not received by the stipulated date, the Nominated 

Authority may, unless it consents to extension of time for submission thereof, 

appropriate the Performance Security and other payments made by such Allottee as 

damages and also terminate the Allotment Agreement. 

Provided, however, in accordance with Rule 13(2)(a) of the Rules, in the event the 

Allottee is the same as the Prior Allottee for the Coal Mine, the Allottee shall be 

entitled to receive the Allotment Order only after it has made payment of the 

applicable additional levy within the due date. 

3.4.5. The Allottee shall be responsible for exploration (if required), obtaining all 

approvals/clearances, acquisition of land, as applicable, rehabilitation, financing, 

development, mining and the operation and maintenance of the Coal Mine, and 

subsequent closure of the Coal Mine in accordance with the provisions of the 

Allotment Order and the Allotment Agreement.  
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3.5. Tests of Responsiveness 

3.5.1. Prior to evaluation of the Application, the Nominated Authority shall determine 

whether each Application is responsive to the requirements of this Allotment 

Document. The Nominated Authority reserves the right to reject any Application 

which is non-responsive and no request for alteration, modification, substitution or 

withdrawal shall be considered or permitted by the Nominated Authority in respect 

of such Application. While making any determination with respect to responsiveness 

of an Application, the Nominated Authority may consider such parameters as it may 

deem relevant, including considerations that the Application: 

a) is received as per the prescribed formats.; 

b) is received by the Last Date including any extension thereof; 

c) is submitted in the manner prescribed in this Allotment Document; 

d) is accompanied by a Power of Attorney as specified in Annexure I and an Affidavit as 

specified in Annexure II; 

e) contains all the information (complete in all respects) as requested in this Allotment 

Document; 

f) does not contain any condition or qualification; 

g) only 1 (one) Application has been made for the Coal Mine, either directly or 

indirectly.  

h) is generally considered to be responsive in terms of any other parameters as may be 

considered relevant by the Nominated Authority. 

3.6. Schedule of Allotment Process 

3.6.1. The Authority shall adhere to the following schedule: 

Sl. Event Description Estimated Date 

1 (i) Publication of Notice Inviting Application 

(NIA) in one English and one Hindi national 

newspaper, (ii) Publication of NIA on the 

website of MoC, (iii) Publication of NIA and 

Allotment Documents on website of MSTC Ltd 

The date of completion of the last sub-event 

T0 Friday, 09 August, 2019  
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Sl. Event Description Estimated Date 

among the above sub-events shall be 

considered T0 

2 Last date of receiving written requests for Site 

Visit/Land Document Inspection 

T0   +  7 Friday, 16 August 2019 

3 Pre-application meeting T0   +  14 Friday, 23 August 2019 

4 Last date of receiving written queries from 

Applicants 

T0   +  17 Monday, 26 August 2019 

5 Last date for written responses to queries by 

the Nominated Authority 

T0   +  21 Friday, 30 August 2019 

6 Last date for registration of Applicant at the 

website of MSTC 

T0   +  35 Friday, 13 September 

2019 

7 Last date for downloading Allotment 

Document at the website of MSTC 

T0   +  35 Friday, 13 September 

2019 

8 Last date for submission of Application (s) T0   +  41 Thursday, 19 September 

2019 

9 Opening of the Application (s) T0    +  45 Monday, 23 September 

2019 

10 Start date of examination of the Application (s) T0    +  46 Tuesday, 24 September 

2019 

11 End date of examination of the Application (s) T0    +  59 Monday, 07 October 2019 

12 Recommendation by the Nominated Authority 

to the Central Government  

T0   +  94 Monday, 11 November 

2019 

13 Approval of Allottee by the Central 

Government 

T1     

14 Intimation to the Allottee (subject to receipt of 

instruction from the Central Government) 

T1  +    2   

16 Execution of the Agreement between the 

Allottee and Nominated Authority 

T1  +    7   

17 Last date for furnishing of Performance 

Security and payment of Fixed and Upfront 

Amount by the Allottee 

T1  +  47   

18 Issuance of Allotment Order by Nominated 

Authority 

T1  +  50   

Note:  *Registration on the website of MSTC Ltd. will commence immediately after publication of the 

NIA. 

* Any change in timeline will be communicated through an addendum to the Allotment 

Document.   

3.7. Upfront Amount 

3.7.1. The Allottee shall be required to pay the Upfront Amount as specified against each 

Coal Mine in Annexure VI. Upfront Amount shall be payable in following three 

instalments:  
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a) 50% of the Upfront Amount shall be payable in accordance with Clause 3.4.3(c); 

b) 25% of the Upfront Amount shall be paid on or prior to expiry of six months from 

the date of issuance of Allotment Order; and 

c) the balance 25% of the Upfront Amount shall be paid on or prior to expiry of twelve 

months from the date of issuance of Allotment Order. 

3.8. Periodic Payments by Allottee 

3.8.1. In addition to the payments specified in Clause 3.4.3, the Allottee shall be required to 

make monthly payments with respect to the coal produced from the Coal Mine (the 

“Reserve Price”). A Reserve Price equivalent to the amount of the royalty on coal as 

per prevalent rate shall be payable on per tonne basis to State Government as per 

actual production of coal by the Allottee, including the Allottee in the State of West 

Bengal where royalty is prescribed in Rs. per tonne. The amount of Reserve Price will 

be calculated as per the extant / prevailing rate of royalty ad-valorem on price of coal 

as reflected in the invoice, excluding taxes, levies and other charges. 

3.8.2. Such payments are required to be made within 20 calendar days of expiry of each 

month with respect to coal produced from the Coal Mine in such calendar month. 

3.8.3. Additionally, the statutory royalty and other levies payable on produced coal will be 

payable as per Applicable Laws. 
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4. Instruction to Applicants 

4.1. General Instructions  

4.1.1. No Applicant shall submit more than 1 (one) Application for the Coal Mine, either 

directly or indirectly. However, the Applicant can apply for more than one coal mine. 

4.1.2. Notwithstanding anything to the contrary contained in this Allotment Document, in 

the event of a conflict, the relevant provisions of the Allotment Agreement shall have 

overriding effect. 

4.1.3. The Nominated Authority reserves the right to postpone, cancel or call for fresh 

Application for the entire Allotment process, at any time, without specifying any 

reason, at its own initiative or in response to any direction from the Central 

Government.  

4.1.4. The documents, including this Allotment Document and all attached documents, 

provided by the Nominated Authority are and shall remain or become the properties 

of the Nominated Authority and are transmitted to the Applicants solely for the 

purpose of preparation and submission of an Application in accordance herewith. 

Applicants are required to treat all such information as strictly confidential and shall 

not use it for any purpose other than for preparation and submission of their 

Application. The provisions of this Clause 4.1.4 shall also apply mutatis mutandis to 

Applications and all other documents submitted by the Applicants in relation to the 

Application, and the Nominated Authority will not return to the Applicants any 

Application, document or any information provided therewith. 

4.1.5. Any award of Allotment Order and execution of Allotment Agreement pursuant to 

this Allotment Document shall be subject to the terms hereof and any documents 

issued pursuant to the Act, the Rules, this Allotment Document or any other 

document referred herein. 

4.1.6. Applicants are also encouraged to revise the Mine Plan so as to mine at an 

accelerated rate, to the best of their capabilities. They are permitted to increase mine 

production to the maximum possible extent and sell the coal.  

4.2. Allotment Document, Queries and Clarifications 

4.2.1. Any queries or request for additional information concerning this Allotment 

Document may be sent by e-mail to the Nominated Authority at 

nomauthority.moc@nic.in substantially in the same format specified in Annexure III 

(Format for seeking clarifications). The email should clearly bear the following subject 

mailto:nomauthority.moc@nic.in
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Line: “Queries/Request for Additional Information: Allotment Document for [insert name of 

the coal mine]”. 

4.2.2. Each query should contain complete details of facts, information and Applicable Law 

germane to the query and also the particulars of the person posing the query. The 

Nominated Authority reserves the right to not answer any query, including any 

query which is incomplete or anonymous. 

4.2.3. The queries should be emailed in .doc, .docx, .xls, .xlsx format, on or before 1700 

hours on the date specified in Clause 3.6.1 for receiving queries.  

4.2.4. The Nominated Authority shall endeavour to respond to the queries within the 

period specified in Clause 3.6.1. However, the Nominated Authority reserves the 

right not to respond to any question or provide any clarification, in its sole discretion, 

and nothing in this Clause 4.2 shall be taken or read as compelling or requiring the 

Nominated Authority to respond to any question or to provide any clarification. The 

Nominated Authority may publish the queries and its responses thereto on the 

website of Ministry of Coal/MSTC, without identifying the source of queries. 

4.2.5. The Nominated Authority may also on its own motion, if deemed necessary, issue 

interpretations and clarifications to all Applicants. All clarifications and 

interpretations issued by the Nominated Authority shall be deemed to be part of the 

Allotment Document. Provided however that, any non-written clarifications and 

information provided by the Nominated Authority, its employees or representatives 

in any manner whatsoever shall not in any way or manner be binding on the 

Nominated Authority. 

4.2.6. Subsequent to opening of the Application, the Nominated Authority shall not 

entertain any query or clarification from Applicants who fail to meet the Eligibility 

Conditions. 

4.2.7. Applications shall be deemed to be under consideration immediately after the 

Applications are opened and until such time the Nominated Authority makes official 

intimation of award/ rejection to the Applicants. While the Applications are under 

consideration, Applicants and/ or their representatives or other interested parties are 

advised to refrain, save and except as required under the Allotment Document, from 

contacting by any means, the Nominated Authority and/ or their employees/ 

representatives on matters related to the Applications under consideration. 
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4.2.8. Save and except as provided in this Allotment Document, the Nominated Authority 

shall not entertain any correspondence with any Applicant in relation to acceptance 

or rejection of any Application.  

4.3. Pre-Application Meeting 

4.3.1. Pre-Application Meeting of the Applicants shall be convened on the designated date 

as mentioned in Clause 3.6.1 at a time and place specified by the Nominated 

Authority. Only those persons who have registered on the website of MSTC with 

respect to the allotment process shall be allowed to participate in the Pre-Application 

Meeting.  

4.3.2. A maximum of 3 (three) representatives of each Applicant shall be allowed to 

participate on production of duly issued authority letter from the Applicant and 

identity documents. During the course of Pre-Application Meeting, the Applicants 

will be free to seek clarifications and make suggestions for consideration of the 

Nominated Authority.  

4.3.3. The Nominated Authority shall endeavour to provide clarifications and such further 

information as it may, in its sole discretion, considered appropriate for facilitating a 

fair, transparent and competitive allotment process. 

4.4. Site Visits and Information 

4.4.1. Prior to submission of Application, the Applicants are encouraged to undertake the 

site visit to Coal Mine, at their cost and ascertain for themselves the site conditions, 

location, communication, climate, availability of power, Applicable Laws and 

regulations, and any other matter considered relevant by them in the manner 

provided herein. This Allotment Document does not however give the unconditional 

or unrestricted right to access the Coal Mine or the right to the Applicants to prospect 

for coal in the Coal Mine or carry out any drilling in the Coal Mine. 

4.4.2. The Applicants which have registered themselves at MSTC‟s website in accordance 

with Clause Error! Reference source not found. shall be eligible to make a request for 

a visit to the Coal Mine on or before 1700 hours on the date specified in Clause 3.6.1 

for receiving request for site visit. Any request received thereafter shall not be 

considered. The site visit to the Coal Mine shall be coordinated through the following 

e-mail address na.moc@nic.in. The email should clearly bear the following subject 

line: “Site Visit for [insert name of the coal mine]”.  

4.4.3. The site visit to the Coal Mine shall be at the cost and risk of the Applicants making 

such request.  

mailto:na.moc@nic.in
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4.4.4. In the event an Applicant undertakes a site visit, then such Applicant shall be liable 

towards any loss or damage caused to the site and/or the Prior Allottee, on account 

of any act or omission of such Applicant or its employees, authorised representatives, 

agents, advisors etc. 

4.5. Submission of Application 

4.5.1. The Applications shall be submitted electronically in accordance with the process 

specified in Clause Error! Reference source not found.. 

4.5.2. In addition to submission of Application electronically, Applicants are also required 

to submit the following documents in original:  

(a) Affidavit in substantially the same format as provided in Annexure II;  

 

(b) Power of Attorney in substantially the same format as provided in Annexure 

I, authorising the signatory of the Application to participate in the allotment 

process and do all acts pursuant thereto on behalf of the Applicant, including 

usage of the digital signature on behalf of the Applicant; and 

 
(c) Document to evidence authority to execute a power of attorney referred in 

clause (b) above, which may be: (i) certified true copy of the charter 

documents; and/or (ii) certified true copy of a resolution passed by the board 

of directors or shareholders of the Applicant. 

 
In addition, an index of documents submitted should be annexed and the 

documents shall contain page numbers: Page [●] of [●] 

4.5.3. Above documents are required to be furnished in a sealed envelope, super scribed on 

the top as under and be addressed to the „Nominated Authority‟ at the address 

mentioned below: 

"Original Documents (Affidavit, Power of Attorney and other documents) 

for Allotment of [Name of coal mine] due on ……….….. (date of 

Application Opening) from M/s……………………… having MSTC 

Registration No. ……………….". 

The Nominated Authority 

Government of India 

Ministry of Coal 

Room No. 120, F-Wing, 
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1st Floor, Shastri Bhawan 

New Delhi - 110001  

4.5.4. The Applicants are requested to send the Affidavit along with Power of Attorney and 

other documents referred at Clause 4.5.2 well in advance so as to be received by the 

Nominated Authority before the Last Date failing which the Application shall not be 

opened. Nominated Authority shall not be liable for loss/non-receipt/late receipt of 

Affidavit or Power of Attorney or other documents in postal transit. 

4.5.5. The Application and all communications in relation to or concerning the Allotment 

Document and the Application shall be in English language. Wherever any document 

is provided in a language other than English, it should be accompanied by 

authenticated English translation of pertinent passages. In the event of any 

discrepancy in two versions, the English translation of the document will be accepted 

for the purpose of Application. 

4.6. Last Date of Submission of Application & Extension 

4.6.1. Applications should be submitted/ uploaded before 1700 hours IST on the Last Date 

in accordance with the process specified in Clause Error! Reference source not 

found.. 

4.6.2. The Nominated Authority may, in its sole discretion, extend the Last Date by issuing 

an Addendum/ Corrigendum in accordance with Clause 4.10 uniformly accessible 

for all Applicants. 

4.7. Modification/ Substitution/ Withdrawal of Applications 

4.7.1. The Applicant may modify, substitute or withdraw its Application after submission, 

provided that written notice of the modification, substitution or withdrawal is 

received by the Nominated Authority prior to the Last Date of Submission of 

Application in accordance with the process specified in Clause Error! Reference 

source not found.. No Application shall be modified, substituted or withdrawn by 

the Applicant after the specified time on the Last Date. 

4.7.2. Any alteration or modification in the Application or additional information supplied 

subsequent to the Last Date, unless the same has been expressly sought for by the 

Nominated Authority, shall be disregarded. 

4.8. Validity of Applications 
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4.8.1. The Applications shall be valid for a period of not less than 150 (one hundred and 

fifty) days from the Last Date for submission of Application. The validity of 

Applications may be extended by mutual consent of the respective Applicants and 

the Nominated Authority. 

4.8.2. In the event that pursuant to the allotment process an Applicant has been declared to 

be the Preferred Applicant or Allottee, then the validity of Applications submitted by 

such Allottee shall stand extended by the mutual consent of the Preferred Applicant 

or the Allottee, as the case may be and the Nominated Authority. 

4.9. Rejection of Applications 

4.9.1. Notwithstanding anything contained in this Allotment Document, the Nominated 

Authority reserves the right to reject any Application and/or to annul the allotment 

process and reject all Applications at any time without any liability or any obligation 

for such acceptance, rejection or annulment, and without assigning any reasons 

thereof.  

4.9.2. The Nominated Authority reserves the right not to proceed with the allotment process 

at any time, without notice or liability, and to reject any Application without assigning 

any reasons. 

4.9.3. Without prejudice to the generality of the foregoing, the Nominated Authority 

reserves the right to reject any Application on any criteria specified in this Allotment 

Document, including without limitation, the following:  

a) Any Application which has not been submitted with all the information and 

details listed in this Allotment Document.  

b) Application is not responsive in terms of Clause 3.5.1.  

c) Any Application which has been submitted without the Affidavit, Power of 

Attorney or other documents referred at Clause 4.5.2 or which are not valid for 

the period specified in Clause 4.8.1.  

d) Any Application which has not been submitted in accordance with the 

Allotment Document. 

4.10. Amendment of Allotment Document 

4.10.1. At any time prior to the Last Date, the Nominated Authority may, for any reason, 

whether at its own initiative or in response to clarifications requested by an 
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Applicant, modify the Allotment Document by the issuance of an Addendum and/or 

Corrigendum. 

4.10.2. Any clarification, Addendum and/or Corrigendum issued hereunder will be in 

writing and shall be accessible to all the Applicants and shall be deemed to be part of 

the Allotment Document. Any verbal clarification shall not be binding on Nominated 

Authority. 

4.10.3. In order to afford the Applicants a reasonable time for taking an Addendum and/or 

Corrigendum into account, or for any other reason, the Nominated Authority may, in 

its sole discretion, extend the Last Date. 

4.11. Cost of Application 

4.11.1. The Applicants shall be responsible for all the costs associated with the preparation of 

their Applications and their participation in the allotment process. The Nominated 

Authority will not be responsible or in any way liable for such costs, regardless of the 

conduct or outcome of the allotment process. 

4.12. Sale of Coal 

4.12.1. The coal produced from the Coal Mine shall be sold by the Allottee through: (i) e-

auction for supply of coal over a period of time pursuant to a contract (“Coal Supply 

Agreement”); and/or (ii) e-auction for specified quantity of coal (“Spot Sale”). The 

sale of coal through the Coal Supply Agreement and/ or through a Spot Sale shall be 

made in a fair and transparent manner, while ensuring that such sale is made on a 

non-discriminatory basis. 

4.12.2. Sale of coal shall be as per the conditions set-out below:  

(a) In every calendar quarter (starting from first day of April with computation 

being on a pro rata basis), out of the total quantity of coal produced by the 

Allottee, the Allottee shall sell not less than the MSME Share (i.e. 25% of the coal 

production from the Coal Mine on ROM basis) to MSME buyers and Balance 

Coal to other buyers on pan-India basis. It is hereby clarified that such MSME 

share may be amended by the Central Government in its sole discretion, and 

such amendment shall be binding on the Allottee. 

(b) The Allottee shall publish, at least 15 days before the intended date of sale of Coal 

to MSME Sector/ other buyers, a pre-sale notice, on its website and on the 

website of respective State Government department and Coal Controller 

Organisation, which will include following information:  
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i. Grade of Coal  

ii. Quantity of Coal available for sale to MSME Sector  

iii. Point of sale 

(c) The Allottee shall ensure that the purchaser of coal under MSME share is a micro 

enterprise, or a small enterprise or a medium enterprise as defined/ covered 

under the Micro, Small and Medium Enterprises Development Act, 2006 and is 

the end user of the coal purchased.  

(d) After the completion of sale of the quantity offered, a post- sale notice shall be 

published within three working days after the sale of coal to MSME Sector/ other 

buyers on Allottee's website and on the website of respective State Government 

department and Coal Controller Organisation. The proforma of the post-sale 

notice will contain:  

i. Grade of Coal.  

ii. Quantity of Coal sold.  

iii. Point of sale.  

iv. The name, address and registration details (if available) of the 

purchaser.  

v. Location and details of the end use plant where the coal is to be used. 

vi. Post sale notice should also be accompanied by the copy of the GST 

invoice.  

The Allottee will also have to send this information by email to the Coal 

Controller Organisation.  

(e) The Allottee will submit a self-declaration to Coal Controller Organisation and 

respective State Government department in form of monthly, quarterly and 

annual report at the end of each month, quarter and financial year, as the case 

may be, containing grade of coal produced, quantity produced, quantity of coal 

sold to MSME Sector and the quantity sold to others. The Allottee shall also 

publish such self-declaration in its website. 

(f) In the event that the actual coal sold to MSME sector is less than the MSME 

Share, then the shortfall shall be adjusted in the subsequent quarter. The MSME 
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Share shall be calculated mandatorily on annual basis at the end of the financial 

year.  

(g) In the event that the Allottee is unable to sell the total MSME Share to MSME 

purchasers on pan India basis at the end of the financial year then such part of 

Unsold Quantity may be sold by the Allottee to any buyer including MSME 

buyers on pan-India and non-discriminatory basis, in the 1st quarter of the next 

financial year.  

(h) It is clarified that even if in a quarter, the total sale to MSME is more than the 

MSME Share, no reduction shall be made in the MSME Share in the subsequent 

quarter. 

(i) The documents related to day to day production, consumption and sale of coal 

will be prepared and maintained by the Allottee and it has to produce, the same 

whenever demanded by any Government agency / Authority.  

(j) For the purposes of this Allotment Agreement: 

i. “Balance Coal” means coal sold from the Coal Mine which is not part of the 

MSME Share.  

ii. “Unsold Quantity” means a positive number equal to the MSME Share 

calculated on annual basis less the actual sale to MSME calculated on annual 

basis at the end of the financial year. 

4.12.3. Consequences of breach of conditions: The consequences of breach of the conditions 

of sale of coal shall be as specified in Clause 6.3 of the Allotment Agreement, which is 

appropriation of Performance Security of an amount equal to 25% of Performance 

Security for the first violation, an amount equal to 50% of Performance Security for 

the second violation and entire Performance Security for the third violation.  

4.13. Security 

4.13.1. Subject to Applicable Laws, the Allottee shall be entitled to create security over the 

Coal Mine through mortgage for the purposes of availing financing from a bank or 

financial institutions for the purposes of financing mining operations at the Coal 

Mine and such security creation shall not require prior approval by the Nominated 

Authority or the Central Government. 

4.13.2. In the event of a default, the banks or financial institutions, as the case may be shall 

be entitled to enforce their security interest in the manner provided by Applicable 
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Law, provided that any transferee of the Coal Mine meets all the Eligibility 

Conditions. 

4.14. Prohibition  

4.14.1. In the cases where Allotment has been made to a joint venture of any two or more 

Government companies or corporations, such companies shall be prohibited from 

alienating or transferring any interest, except for taking of loans or advances from a 

bank or financial institution, in the joint venture of whatsoever nature including 

ownership in favour of a third party.  
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5. Instructions for Electronic Application  

5.1. Registration on MSTC’s Website 

5.1.1. In order to submit Applications for the Coal Mine, an Applicant would be required to 

register itself with the e-auction website of MSTC: http://www.mstcecommerce.com. 

For this the Applicant should visit the website of MSTC and click on the button 

“Registration”. Applicant should read carefully the GENERAL TERMS & 

CONDITIONS OF e-AUCTION that will appear on screen and click on the 

“Proceed” button at the bottom of the page. Applicant should also read the 

subsequent APPLICANT SPECIFIC TERMS & CONDITIONS (BSTC) and click on 

“Agree” to proceed for registration. An online Registration Form will appear on 

screen and Applicant would be required to fill up the same. During this process, 

Applicant would be required to create its “User ID” and “password” and keep note 

of the same. Applicant should ensure that the secrecy of its User ID and password is 

maintained at all time and Applicant shall alone be responsible for any misuse of the 

User ID and password. Applicant may also refer to the “Applicant‟s Guide” available 

online in the above mentioned website for assistance. 

5.1.2. On successful submission of the online registration form, Applicant shall receive a 

confirmation e-mail at the registered email address advising the Applicant to submit 

the following documents: 

a) Self attested Income Tax PAN Card of the Applicant. 

b) Two passport size photographs of the Authorized Signatory of the Applicant. 

c) Letter of Authorization from Chairman/MD/Directors/CEO/Company 

Secretary of the Applicant in favour of the Authorized Signatory in the standard 

format available in the website. The Authorized Signatory shall be the person 

responsible for submission of Application. For this purpose, the Authorized 

Signatory will need to be in possession of a Class III signing type digital 

signature issued by an Indian certifying authority, the details of which shall be 

provided in this authorization letter.  

d) Proof of Identity of the Authorized Signatory in the form of Company ID 

Card/PAN Card/Voter ID Card 

e) Copy of the confirmation email. 

5.1.3. Applicant shall be required to electronically submit all the above documents to MSTC 

for verification and activation of their account. Applicants are required to send 
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scanned copies of the aforementioned documents to the following designated email 

address: 

coalblock@mstcindia.co.in 

5.1.4. It may be noted that Applicants need not visit any of the offices of MSTC for 

submission of the aforementioned documents. However, the Applicants may contact 

the following offices of MSTC for seeking assistance on the login or registration 

process. 

MSTC Limited 
E-Commerce Division 
225-F, A.J.C Bose Road, 2nd Floor Kolkata - 700 020 

 
 
5.1.5. Once the complete set of aforementioned documents is electronically received from 

an Applicant, MSTC shall activate the Applicant‟s login after verification / scrutiny 

of the documents. MSTC reserves the right to call for additional documents from the 

Applicant if required, prior to registration and activation of the Applicant‟s login. 

5.1.6. On completion of the above stated registration process, an Applicant shall be able to 

log in to MSTC‟s website. After activation of login, an Applicant will be issued a 

“Photo Identity Card” by MSTC bearing the photograph and signature of the contact 

person. The Photo Identity Card shall be duly authenticated by MSTC‟s officials. 

5.1.7. The Applicants are also needed to submit a Declaration in the format provided in the 

MSTC‟s website (www.mstcecommerce.com/auctionhome/coalblock/index.jsp) 

stating that the applicant is a Government company or corporation. This declaration 

is to be submitted after registration by email to coalblock@mstcindia.co.in with the 

subject line “Declaration by Government Companies for allotment of coal mines.” 

5.1.8. Applicants who have registered earlier with the website need not register again.  

5.2. Downloading Information About Coal Mine 

5.2.1. There are two sets of documents available for downloading from the website of 

MSTC.  

5.2.2. First set of documents can be downloaded without registration on MSTC‟s website. 

These documents may include the following: (a) Standard format of the Allotment 

Document. Subsequent to registration, Applicants may download the second set of 

documents, including: (a) the Mine Dossier specific to the Coal Mine; and (b) 

Allotment Document. 

mailto:coalblock@mstcindia.co.in
http://www.mstcecommerce.com/auctionhome/coalblock/index.jsp
mailto:coalblock@mstcindia.co.in
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5.2.3. Information available on the website of MSTC without registrationis provided in 

order to assist the potential Applicants to make a determination regarding their 

participation in the Allotment process. Based on such determination, potential 

Applicants may decide to participate in the Allotment process with respect to one or 

more coal mines. 

5.2.4. The Applicant may note that the files containing information about the coal mines 

can be in various formats including without limitation, doc, xls, ppt, pdf, jpg, jpeg, 

zip etc. and it shall be the responsibility of the Applicant to have suitable facilities at 

its end to download the uploaded files. 

5.3. Digital Signature Certificate 

5.3.1. An Applicant shall be required to possess a valid Digital Signature Certificate (DSC) 

of signing type to be able to submit its Application and to participate in the electronic 

auction on MSTC‟s website. For this purpose, Applicants shall be required to 

authorize its Authorized Signatory to procure a class III DSC of signing type from 

any Certifying Authority or their authorized agencies in India.  

5.3.2. The competent authority of the Applicant shall be required to issue a Letter of 

Authority in favour of the Authorized Representative in the standard format 

provided on the homepage of the website of MSTC mentioning therein the serial 

number of the DSC of the Authorized Representative. The competent authority shall 

be one of the following: 

a) Chairman of the Company 

b) Managing Director of the Company 

c) Chief Executive Officer of the Company 

d) Company Secretary of the Company 

5.3.3. The Applicant may note that only one User ID will be mapped with a given DSC for 

the Authorised Signatory. DSC once mapped with a particular User ID of an 

Applicant will normally not be changed and therefore Applicants are advised to 

carefully select the DSC before forwarding the same to MSTC for mapping. 

5.3.4. The Digital Signature Certificate will be used to digitally sign the Applications that 

the Applicant will submit online.  

5.3.5. It will be the sole responsibility of the Applicant and its respective Authorised 

Signatory to maintain the secrecy of the password for the Digital Signature 
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Certificate. The Applicant shall be solely responsible for any misuse of the DSC and 

no complain or representation in this regard shall be entertained at any stage by 

MSTC or the Nominated Authority. 

5.3.6. The Applicant may note that the following configurations will be required to be 

undertaken in their Internet Explorer browsers for smooth functioning of the website. 

5.3.7. The system requirements are as follows: 

a) Operating System –Windows 7 and above 

 

b) Web Browser- Preferred „IE 8‟ and above. 

 

c) Security Settings :  

i) Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., 

Remove the tick from the box mentioning “Enable Protected Mode”. 

ii) Tools => Internet Options => Security =>Custom Level=> 

 Active X control & plug-ins: Enable all Active-X Controls  

 Scripting: Enable “Allow Status Bar Update Via Script” 

 Disable “Use Pop-up Blocker” 

 

d) Java: JRE 8 Latest update 

 

e) Other Settings: 

i) View => Toolbars=> “Tick” Status Bar. 

ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing 

history/Delete Browsing History”=> Temporary Internet Files=>Activate 

“Every time I Visit the Webpage”. 

f) For new Version of IE or other “Active –X Filtering” under Tools should not be 

ticked. 

g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website 

“http://www.mstcecommerce.com” 

5.4. Application Process 

5.4.1. The entire Application process will be in single stage and will be online on MSTC‟s 

website.  

5.4.2. The intending applicants may send a letter in their official letterhead addressed to 

MSTC Limited Kolkata mentioning the name of the coal mine(s) for which they wish 

to make application for allotment. Based on the said letter, MSTC shall enable the 

applicant to download the Mine Dossier specific to the Coal Mine; and Allotment 

Document. The scanned copy of the letter may be sent to the email mentioned below 
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droy@mstcindia.co.in  

5.4.3. The submission of Application shall be open to all Applicants who have registered 

for the Coal Mine. In this process, the Applicant, after logging in to the above stated 

website, will have to click on the link “View Details”. In the next page, the Applicant 

shall have to go to the link “Allotment of Coal Mines”. Thereafter, the Applicant will 

have a bouquet under “My Menu” having 3 (three) sub-menus – “Bid Floor 

Manager”, “Upload Documents” and “Attach Documents”. 

5.4.4. Bid Floor Manager 

5.4.4.1. Once the Applicant clicks on this sub-menu, it will display a list of Coal Mine(s) for 

which the Applicant has registered for downloading the remaining documents. On 

clicking on any of these Coal Mine(s), the Applicant will be directed to a screen 

where it can fill up the Application template and save the data. The Applicant can 

edit such data as many times as it wishes till the final submission is made by 

clicking the “Final Submission” button. 

5.4.4.2. The final submission of Application shall be digitally signed by the Applicant using 

the digital signature, use of which has been duly authorized on behalf of the 

Applicant and which was used at the time of registration. Any digital signature 

certificate other than the above shall not be acceptable for Application submission 

by the system. 

5.4.5. The Applicant may note that the “Final Submission” button for Application will be 

activated only after the Application has been saved. 

5.4.6. The Applicant should also note that an Application will be considered as submitted if 

and only if the Applicant has clicked on the “Final Submission” button. Only such 

Applications will be opened which have been finally submitted. It is further clarified 

that saving of Application without final submission will be treated as non submission 

of Application. 

5.4.7. The Applicant shall also have to upload the documents (Formats as per Annexure IV, 

scanned copies of Affidavit, Power of Attorney, Board Resolution etc) along with the 

Application, as required under the Allotment Document. These documents will need 

to be uploaded in pdf format only (the file size should be limited to 4 MB; in case of 

larger files, they may be split into multiple files with suitable nomenclature). Files in 

formats other than pdf shall not be accepted. For this, the Applicant shall first click on 

the link “Upload documents” and upload the files in support of its Application. 

mailto:droy@mstcindia.co.in
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5.4.8. After uploading these documents, the Applicant shall have to attach them with the 

specific Coal Mine(s) for which it is intending to submit the Application. It may be 

noted by the Applicant that in case it intends to use the same document for more than 

one Coal Mine, it does not need to upload the same document every time. The 

document, once uploaded, can be attached with Applications for multiple mine(s), if 

desired. 

5.4.9. The Applicant should note that only a file which is “attached” with a specific Coal 

Mine(s) shall be considered during evaluation of the Application. Files which are not 

attached to any Coal Mine(s) shall not be considered for evaluation. 

5.4.10. Upon successful final submission, the Applicant shall receive a system 

generatedApplication acknowledgement. 

5.4.11. If after final submission of Application and before the Last Date anApplicant wishes 

to make changes in its Application, it can do so by clicking the “Delete Application” 

option. By doing so, the entire Application submitted by the Applicant will get 

deleted. A system generated email will be sent to the Applicant acknowledging the 

deletion. The Applicant will be able to save and submit its new Application again. If 

an Applicant deletes its Application and does not submit its new Application in the 

same manner as stated above, its Application will not come up for opening or further 

processing. 

5.4.12. If after final submission of Application and before the Last Date an Applicant wishes 

to withdraw its Application, it can do so by clicking the “Withdraw Application” 

option. By withdrawing an Application, Applicant will lose the opportunity to re-

submit its Application against the Coal Mine(s). 

5.4.13. The Applicants shall also note that online submission of Application with documents 

and offline submission of certain original documents shall be allowed only up to time 

specified in “Schedule of Allotment Process” (Clause 3.6.1). Applicants in their own 

interest are advised to complete the entire process well in advance to avoid any last 

minute hiccup / technical problems. No complaints shall be entertained in this 

regard at any stage. 

5.4.14. Applicants should note that words „Bidder‟ and „Technical Bid‟ have been used 

interchangeably with „Applicant‟ and „Application‟ on the Digital platform. 
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6. Evaluation Criteria 

6.1. Evaluation of Applications 

6.1.1. In the event that only one Application is considered to be in compliance with all the 

Eligibility Conditions and is responsive pursuant to Clause 3.5 for the Coal Mine, the 

Applicant which submitted such Application shall be recommended as the 

“Preferred Applicant”.  

6.1.2. In the event that, more than one Application is considered to be in compliance with 

all the Eligibility Conditions and responsive pursuant to Clause 3.5 for the Coal Mine, 

then such Applications shall be considered for the purpose of selection from amongst 

the qualified Applicants, in accordance with following norms.  

a) Coal Mines shall be allotted in ascending order on the basis of size of the coal 

mine i.e. a coal mine having lowest extractable reserves shall be allotted first and 

a coal mine with highest extractable reserves shall be allotted last.  

b) A score shall be calculated for the qualified Applicants on the basis of the 

following criteria: 

S. 
No. 

Criteria Score Weightage 

1 Networth of the Applicant on the basis of 
standalone audited financial statements for 
previous financial year i.e. FY 2018-19 

 

50% 

Networth >= 10% of Value of Estimated Reserves of 
the Coal Mine 

10 

2% of Value of Estimated  Reserves <= Networth < 
10% of Value of Estimated Reserves 

To be 
calculated 
on linear 

basis 

Networth < 2% of Value of Estimated Reserves of 
the Coal Mine 

0 

2 Average amount of royalty paid* by the Applicant 
to the State Governments during previous 2 
financial years i.e. FY 2017-18 and FY 2018-19 (X) 
vis-à-vis One year royalty calculated on the basis 
of peak rated capacity of the Coal Mine as per the 
approved Mine Plan (Y) 

 

20% 
X >= Y 10 

75% of Y <= X < Y 7.5 

50% of Y <= X < 75% of Y 5.0 

25% of Y <= X < 50% of Y 2.5 

X < 25% of Y 0 

3 Total quantity of coal mined by the Applicant  30% 
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S. 
No. 

Criteria Score Weightage 

during previous 2 financial years i.e. FY 2017-18 
and FY 2018-19 (A) vis-à-vis peak rated capacity of 
the Coal Mine as per the approved Mine Plan (B) 

A >= B 10 

75% of B <= A < B 7.5 

50% of B <= A < 75% of B 5.0 

25% of B <= A < 50% of B 2.5 

A < 25% of B 0 
*To be considered for minerals covered under the Second Schedule of MMDR Act, 1957.  
 

The Applicant achieving the highest score shall be recommended as Preferred 

Applicant.  

However, in case of a tie between the scores of two or more qualified Applicants, 

then the following parameters shall be considered with equal weightage and the 

Applicant achieving the highest score shall be recommended as Preferred Applicant:  

a) Total Mineral production divided by Total number of employees (Average of 

last two financial years)  

b) Total number of fatalities per 1000 persons employed (Average of last two 

financial years)  

For the purpose of abovementioned clause, networth and Value of Estimated 

Reserves of the Coal Mine shall be estimated in the following manner: 

(i) Networth: Networth shall be calculated as the aggregate value of the paid-up 

share capital and all reserves created out of the profits and securities premium 

account, after deducting the aggregate value of the accumulated losses, deferred 

expenditure, Intangible Assets, redemption reserves, reserves made for any 

specific purpose and miscellaneous expenditure not written off, as per the 

audited balance sheet, but does not include reserves created out of revaluation of 

assets, write-back of depreciation and amalgamation.  

In the event the Applicant is a joint venture company, the networth of the 

Applicant shall be estimated on the basis of pro-rata shareholding of the joint 

venture partners in the joint venture company. For example, the Applicant is a 

joint venture company with three joint venture partners X, Y and Z having 

shareholding in the ratio of 50:30:20, then the networth of Applicant shall be 

estimated as = (50% * Networth of X) + (30% * Networth of Y) + (20% * Networth 

of Z). 
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Networth shall be estimated on the basis of standalone audited financial 

statements of previous financial year i.e. FY 2018-19. The Applicant is required to 

submit a certificate from its statutory auditor or the statutory auditor of the joint 

venture partners in case the Applicant is a joint venture company, certifying i) the 

networth and ii) that networth has been estimated in accordance with this Clause 

6.1.2(i). Networth certificate is required to be submitted on MSTC‟s website in 

accordance with Clause 5.4.7. 

(ii) Value of Estimated Reserves: Value of Estimated Reserves shall be estimated as 

an amount equal to product of a) PRC of the coal mine multiplied by 30 and b) 

CIL Notified Price of the relevant grade(s) of coal by CIL or any of its 

subsidiaries, as may be territorially relevant to the Coal Mine. Value of Estimated 

Reserves shall be as provided in Annexure VI of this Allotment Document. 

Additionally, the Applicant is required to submit following certificates from its 

statutory auditor or the statutory auditor of the joint venture partners in case the 

Applicant is a joint venture company: 

a) Amount of royalty paid by the Applicant to the State Governments during 

previous 2 financial years i.e. FY 2017-18 and FY 2018-19 

b) Total quantity of coal mined by the Applicant during previous financial year i.e. 

FY 2018-19. In case of more than one operational coal mine, mine-wise production 

should be certified by the statutory auditor. 

Such certificates are required to be submitted on MSTC‟s website in accordance with 

Clause 5.4.7. 
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7. Performance Security  

7.1. Instructions Related to Performance Bank Guarantee  

7.1.1. The Allottee shall provide to the Government an irrevocable and unconditional 

guarantee from an Acceptable Bank, for the performance of its obligations within 

such time as specified in Clause 3.6.  

The Performance Security shall be the aggregate amount of: (a) one year royalty 

calculated on the basis of peak rated capacity of the Coal Mine as per the approved 

Mine Plan, payable to respective State Government with respect to the Coal Mine; 

and (b) the annual peak rated capacity of the Coal Mine as per the approved Mine 

Plan multiplied by the Reserve Price.  

For the purpose of computation of the amount of Performance Security, 80% of peak 

rated capacity shall be considered. 

For the purpose of calculation of Performance Security, royalty and Reserve Price 

shall be determined as follows: 

a) Except for Coal Mine(s) located the State of West Bengal, the royalty and 

Reserve Price shall be determined on the basis of CIL Notified Price. 

b)  For Coal Mine(s) located the State of West Bengal, Reserve Price shall be 

determined on the basis of CIL Notified Price and the royalty shall be 

determined as per the prevailing rate of royalty. 

The Performance Security shall be in substantially the form as provided in the 

Allotment Agreement. 

However, in case of regionally explored coal mines, the Performance Security shall be 

equal to 10% (ten percent) of the estimated exploration expense during the 

exploration period i.e. till completion of exploration and preparation and submission 

of Geological Report in accordance with the Allotment Agreement. 

7.1.2. The amount of Performance Security shall be revised in following events: 

a) In case of any revision in rate of royalty, the amount of Performance Security 

shall be revised accordingly. Such revision shall take place at the beginning of 

the financial year which is subsequent to the financial year in which the rate 

of royalty is revised, as stipulated in Clause 7.1.2 (d); and/or  
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b) In case of any revision in CIL Notified Price, the amount of Performance 

Security shall be revised accordingly. Such revision shall take place at the 

beginning of the financial year which is subsequent to the financial year in 

which the CIL Notified Price is revised, as stipulated in Clause 7.1.2 (d); 

and/or 

c) In case of any revision in the Mine Plan in accordance with Clause 8.1, the 

amount of Performance Security shall be revised accordingly upon approval 

of revision to the Mine Plan. Such revision shall take place at the beginning of 

the financial year which is subsequent to the financial year in which the Mine 

Plan is revised, as stipulated in Clause 7.1.2 (d).  

In case of any downward revision in Peak Rated Capacity (“PRC”) in 

accordance with Clause 8.2.2, the amount of Performance Security shall be 

revised accordingly. Such revision shall take place at the beginning of the 

financial year which is subsequent to the financial year in which the PRC is 

revised, as stipulated in Clause 7.1.2 (d). 

d) The revision to the amount of Performance Security shall be carried out once 

in every financial year. Upon such revision, the bank guarantee constituting 

the Performance Security shall be substituted with another bank guarantee of 

the revised value issued in accordance with this Clause 7, within a period of 

30 days from the beginning of financial year i.e. by April 30 of every year, in 

case of revision under each of sub-clause (a), (b) and (c) above.  

It is clarified that revisions to the amount of Performance Security may occur under 

sub-clause (a), (b) and (c) above, simultaneously, if such sub-clauses are applicable. 

7.1.3. The Performance Security should remain valid for such duration as specified in the 

Allotment Agreement. 

7.2. Appropriation of Performance Security 

7.2.1. The Performance Security may be appropriated by the Nominated Authority in the 

manner specified in the Allotment Agreement. 
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8. Other Provisions 

8.1. Revision of Mine Plan upon allocation 

8.1.1. Upon allocation of the Coal Mine, the Allottee may revise the Mine Plan for 

extraction of more coal in accordance with the provisions of Applicable Law and the 

Allotment Agreement. 

8.2. Flexibility in Coal Production Schedule 

8.2.1. The Allottee shall be allowed to manage its coal production quantity (subject to the 

cap as per the Mine Plan) in the event of any economic downturn or other such event. 

Further, the actual production of coal in any year should not be less than 50% of the 

coal production as per the Mine Plan. However, in any five year block, the Allottee is 

required to produce at least 70% of the coal as per the Mine Plan. It is clarified that 

five year block shall be counted from the first financial year of commencement 

of production in the Coal Mine. 

It is clarified that in such event, the MSME Share on annual basis shall remain the 

same. 

8.2.2. In the event that State Pollution Control Board or any other statutory body approves 

the mining operations with a downward revision in Peak Rated Capacity (“PRC”), 

then the minimum production criteria as explained above will be applicable on this 

modified PRC. 

8.3. Miscellaneous 

8.3.1. The allotment process shall be governed by, and construed in accordance with the 

laws of India and the dispute resolution shall be subject to Section 27 of the Act. 

8.3.2. The Nominated Authority, in its sole discretion and without incurring any obligation 

or liability, reserves the right, at any time, to; 

a) suspend and/ or cancel the allotment process and/ or amend and/ or 

supplement the allotment process or modify the dates or other terms and 

conditions relating thereto; 

b) consult with any Applicant in order to receive clarification or further 

information; 

c) retain any information and/ or evidence submitted to the Nominated Authority 

by, on behalf of, and/ or in relation to any Applicant; and/ or 
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d) independently verify, disqualify, reject and/ or accept any and all submissions 

or other information and/ or evidence submitted by or on behalf of any 

Applicant. 

8.3.3. It shall be deemed that by submitting the Application, the Applicant agrees and 

releases the Nominated Authority, its employees, agents and advisers, irrevocably, 

unconditionally, fully and finally from any and all liability for claims, losses, 

damages, costs, expenses or liabilities in any way related to or arising from the 

exercise of any rights and/ or performance of any obligations hereunder, pursuant 

hereto and/ or in connection with the allotment process and waives, to the fullest 

extent permitted by Applicable Laws, any and all rights and/or claims it may have in 

this respect, whether actual or contingent, whether present or in future. 

8.4. Proprietary Data 

8.4.1. All documents and other information supplied by an Applicant to the Nominated 

Authority shall remain or become the property of the Nominated Authority. It will 

not return any Application or any information provided by the Applicant. 
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9. Annexure I: Format of Power of Attorney 

 

(To be stamped in accordance with relevant Stamp Act) 

Power of Attorney for signing of Application 

Know all men by these presents, We, …………………………… (name and address of the 

registered office) do hereby irrevocably constitute, nominate, appoint and authorise Mr. 

/ Ms (Name), son/daughter/wife of ……………………………… and presently residing 

at ………………………………….., who is presently employed with us and holding the 

position of ………………………….., as our true and lawful attorney (hereinafter referred 

to as the “Attorney”) to do in our name and on our behalf, all such acts, deeds and 

things as are necessary or required in connection with or incidental to submission of our 

Application for the [name] Coal Mine (“Coal Mine”) in response to the Allotment 

Document issued by Nominated Authority, Ministry of Coal (the “Nominated 

Authority”) including but not limited to signing and submission of all applications, 

affidavits and other documents and writings, participate in applicants‟ and other 

conferences, execution of Allotment Agreement and providing information / responses 

to the Nominated Authority, representing us in all matters before the Nominated 

Authority, and generally dealing with the Nominated Authority in all matters in 

connection with or relating to or arising out of our application for the said Coal Mine 

and/or upon award thereof to us and/or till the entering into of the Allotment 

Agreement with the Nominated Authority.  

AND we hereby agree to ratify and confirm and do hereby ratify and confirm all acts, 

deeds and things done or caused to be done by our said Attorney pursuant to and in 

exercise of the powers conferred by this power of attorney and that all acts, deeds and 

things done by our said Attorney in exercise of the powers hereby conferred shall and 

shall always be deemed to have been done by us.  

IN WITNESS WHEREOF WE, ………………………….., THE ABOVE NAMED 

PRINCIPAL HAVE EXECUTED THIS POWER OF ATTORNEY ON THIS 

……………………… DAY OF …………………….., 20.…..  

 

For……………………………..  

(Signature, name, designation and address)  
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Witnesses:  

1.  

2.  

Accepted Notarised  

(Signature, name, designation and address of the Attorney)  

Notes:  

The mode of execution of the power of attorney should be in accordance with the procedure, if any, 

laid down by the Applicable Law and the charter documents of the executant(s) and when it is so 

required, the same should be under common seal affixed in accordance with the required 

procedure.  

Wherever required, the Applicant should submit for verification the extract of the charter 

documents and documents such as a board or shareholders resolution authorizing the execution of 

this power of attorney.  

To be submitted separately for each application. 
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10. Annexure II: Format of Affidavit 

To be submitted separately for each application. 

 (To be stamped in accordance with the relevant Stamp act and duly sworn before Notary public) 

Affidavit 

 

I, ____________________ aged ______ years, resident of __________ working as ____________ 

an Authorised Signatory on behalf of _________________________ (name of Applicant) (the 

“Applicant”) hereby state as under: 

  

1.  I say that I am the [Insert designation of the deponent] of the Applicant. I am 

conversant with the facts and circumstances surrounding the subject of this Affidavit 

and have been authorized to depose to the same pursuant to the power of attorney 

dated [____________]. I am filing this Affidavit to place on record verification of facts 

and documents in connection with the allotment process concerning [name of the 

coal mine].    

2. [Insert separate paragraphs for each document/information provided brought on 

record on the website of the MSTC or physically submitted with the Nominated 

Authority, in a chronological sequence]. 

3. That nothing has been concealed in the information submitted as mentioned above.  

Solemnly affirmed and verified on this ______ day of [month] 2016 at [place].  

 

 

 

 

(Signature) 

Name, Designation & Seal 

VERIFICATION 

 

I, [●], the [Insert designation of the deponent] of the Applicant above named, having my 

office at [●], do hereby solemnly declare that what is stated above in paragraphs [●] to [●] 

are on the basis of the books and records of the Applicants, and verify that the contents of 

the above affidavit are true and correct, no part of it is false and nothing material has been 

concealed there from. 

 

Verified at ______ day of [month] 2019 at [place]. 

 

Deponent 

(Signature) 

   Name, Designation & Seal 
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11. Annexure – III: Format for Seeking Clarifications. 
 
 

(Applicable only for the Pre-Application meeting before submission of the Application in 

response to the Allotment Document)  

 

S. No Document Clause No. 
and Existing 
Provision 

Clarification 
Required 

Suggested Text 
for 
Amendment, if 
any 

Rationale for 
Clarification or 
Amendment 
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12. Annexure – IV: Formats to be submitted by the Applicants 

(On the letter head of the Applicant) 

 

SCHEDULE I Application Form 

SCHEDULE II Other Information 

* Above Schedules are to be filled, signed, stamped, scanned and uploaded along with Application on 

the MSTC’s digital platform. 
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SCHEDULE I: APPLICATION FORM 

 

ALLOTMENT OF COAL MINE TO ELIGIBLE APPLICANTS  

  

MSTC Registration No.  

Applicant's Name   

Registered Address  

 

 

 

 

Person to be contacted   

Designation   

Tel. No(s).    

Mobile No.   

Fax No(s).  

E-mail address  

 

To  

The Nominated Authority 

Ministry of Coal 

Government of India 

Shastri Bhawan, 

New Delhi - 110001 

 

Dear Sir,  

Having read and examined in detail the Conditions of Allotment Document dated [………] 

and subsequent Amendment(s) and Clarification(s), we do hereby furnish our Application 

for Allotment of [name of coal mine] Coal Mine as mentioned at number [……….] of the list 

of coal mines at Annexure VI.  

We have understood the instructions and the terms & conditions mentioned in the 

Allotment Document furnished by you and have thoroughly examined the specifications of 

the aforementioned Coal Mine as provided by you in the Allotment Document and are fully 

aware of the technical and other details of the Coal Mine and are otherwise fully satisfied 

with respect to the information provided.  

We further confirm that no change or substitution in respect of reference Coal Mine, as 

specified in the Allotment Document, for meeting the specified Eligibility Conditions shall 

be offered by Applicant. 

We understand that it is not mandatory for you to open our Application and it will be 

opened only if we are otherwise eligible for participating in the Allotment process. We 

understand and confirm that your decision in this regard shall be final and binding on us.  
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We understand and agree that the Nominated Authority does not bind itself to accept any 

application or to give any reasons for their decision. The decision of the Nominated 

Authority shall be final and binding on us in all matters /issues arising out this allotment 

process.  

We confirm that we have furnished all the relevant information in respect of coal mines to 

the Nominated Authority in the following Schedules: 

SCHEDULE I Application Form 

SCHEDULE II Other Information 

We further agree that if our proposal is accepted, we shall provide an irrevocable 

Performance Guarantee in your favour in the form of Bank Guarantee of amount calculated 

on the basis of formula specified in Clause 7.1.1 within such time as specified in Clause 3.6, 

of the Allotment Document. 

We confirm that our Application shall remain valid for your acceptance for a period of One 

Twenty (120) days from the date of opening of the Application. 

We hereby declare that only the Company, persons or firms interested in this proposal as 

principal or principals are named herein and that no other company, person or firm other 

than one mentioned herein, have any interest in this Application or in the Allotment 

Agreement to be entered into, if we are awarded this Coal Mine, and that this Application is 

made without any connection with any other persons, firm or party likewise submitting an 

Application and that this Application is in all respects for and in good faith without 

collusion or fraud. 

In terms of Clause 4.5.2(b) of Allotment Document, we are enclosing herewith Power of 

Attorney, Board Resolution & Affidavit in the name of the person who has signed this offer 

on behalf of the firm. 

Date Signature 

Place 

Name of Authorized Signatory 

 

 

 Designation 

 Company‟s Name 
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SCHEDULE II: OTHER INFORMATION  

 

ALLOTMENT OF COAL MINE TO ELIGIBLE APPLICANTS  

(Data/information in respect of Eligibility criteria) 

 

A. Details in line with the requirement of the Clause 3.2 of Allotment Document. 

 

S. No. Parameter  

1.  Name of Applicant  

2.  Registered Address  

3.  Name of shareholders holding equal to or more than 26% share 

(in case the Applicant is a joint venture company, shareholding 

of each JV Partner is required to be provided) 

 

4.  Whether the Applicant is incorporated for the purpose of 

mining?  

If yes, please submit copy of MoA and relevant extract of AoA 

of the Applicant indicating that the Applicant incorporated for 

the purpose of mining; 

 

Yes / No 

5.  Whether the Applicant is engaged in mining activity? 

If yes, please submit a certificate from the statutory auditor 

certifying that the Applicant is engaged in mining activity 

Or 

If no, please submit a letter of recommendation for allotment 

addressed to the Nominated Authority from the State 

Government/ Central Government, as the case may be, in 

accordance with Clause 3.2.2. 

Yes / No 

 

B. Details in line with the requirement of the Clause 6.1 of Allotment Document. 

S. No. Criteria  

1 
Networth of the Applicant as at the end of FY 2018-

19 (Rs. Crore) 

 

2 

Amount of royalty paid to the State Governments for 

minerals covered under the Second Schedule of 

MMDR Act, 1957, during previous 2 financial years 

i.e. FY 2017-18 and FY 2018-19 (Rs. Crore) 

 

 FY 2017-18  

 FY 2018-19  

3 

Quantity of coal mined by the Applicant during 

previous 2 financial years i.e. FY 2017-18 and FY 

2018-19 (MT)* 
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S. No. Criteria  

 FY 2017-18  

 FY 2018-19  

* in case of more than one mine, such details are required to be provided for each mine separately. 

 

Date Signature 

Place 

 

Name of Authorized Signatory 

 

 Designation 

 Company‟s Name 
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13. Annexure – V: Allotment Agreement 

 

[To be provided separately.] 



  

14. Annexure –VI: Particulars of the Coal Mine and Upfront Amount 

S. 

No 

Coal Mine State Prior Allottee Value of 

Estimated 

Reserves 

(Rs. 

Crore) 

Fixed 

Amount 

(Rs.) 

Upfront Amount (Rs.) 

First 

Installment 

Second 

Installment 

Third 

Installment 

1 Tokisud 

North 

Jharkhand GVK Power (Govindwal 

Sahib) Ltd. 

9521.28  To be provided 

separately 

10,86,81,908.50 5,43,40,954.25 5,43,40,954.25 

 

 

 



  

Important Notice 

 
The information contained in this Allotment Document or subsequently provided to Applicant(s), 
whether verbally or in documentary or any other form by or on behalf of the Nominated Authority or 
any of its employees or advisors, is provided to Applicant(s) on the terms and conditions set out in 
this Allotment Document. 

This Allotment Document is neither an agreement nor an offer by the Nominated Authority to the 
prospective Applicants or any other Person. The purpose of this Allotment Document is to provide 
interested parties with information that may be useful to them in making their Applications pursuant 
to this Allotment Document. This Allotment Document includes statements which reflect various 
assumptions and assessments arrived at by the Nominated Authority in relation to the Coal Mine. 
Such assumptions, assessments and statements do not purport to contain all the information that each 
Applicant may require. This Allotment Document may not be appropriate for all Persons, and it is 
not possible for the Nominated Authority, its employees or advisors to consider the investment 
objectives, financial situation and particular needs of each party who reads or uses this Allotment 
Document. The assumptions, assessments, statements and information contained in the Allotment 
Document, including specifically the Mine Dossier, may not be complete, accurate, adequate or 
correct. Each Applicant should, therefore, conduct its own investigations and analysis and should 
check the accuracy, adequacy, correctness, reliability and completeness of the assumptions, 
assessments, statements and information contained in this Allotment Document and obtain 
independent advice from appropriate sources.  

Information provided in this Allotment Document to the Applicant(s) has been collated from several 
sources some of which may depend upon interpretation of Applicable Law. The information given is 
not intended to be an exhaustive account of statutory requirements and should not be regarded as 
complete. The Nominated Authority accepts no responsibility for the accuracy or otherwise for any 
statement contained in this Allotment Document.  

The Nominated Authority, its employees and advisors make no representation or warranty and shall 
have no liability to any Person, including any Applicant under any law, statute, rules or regulations 
or tort, principles of restitution or unjust enrichment or otherwise for any loss, damages, cost or 
expense which may arise from or be incurred or suffered on account of anything contained in this 
Allotment Document or otherwise, including the accuracy, adequacy, correctness, completeness or 
reliability of the Allotment Document and any assessment, assumption, statement or information 
contained therein or deemed to form part of this Allotment Document or arising in any way from 
participation in this Allotment process.  

The Nominated Authority also accepts no liability of any nature whether resulting from negligence or 
otherwise howsoever caused arising from reliance of any Applicant upon the statements contained in 
this Allotment Document.  

The Nominated Authority may in its absolute discretion, but without being under any obligation to 
do so, update, amend or supplement the information, assessment or assumptions contained in this 
Allotment Document.  

The issue of this Allotment Document does not imply that the Nominated Authority is bound to select 
a Applicant or to appoint the Preferred Applicant as Allottee for the Coal Mine and the Nominated 
Authority reserves the right to reject all or any of the Applicants or Applications without assigning 
any reason whatsoever.  

Each Applicant shall bear all its costs associated with or relating to the preparation and submission of 
its Application including but not limited to preparation, copying, postage, delivery fees, expenses 
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associated with any demonstrations or presentations which may be required by the Nominated 
Authority or any other costs incurred in connection with or relating to its Application. This 
Allotment Document is not transferable.  

The Mine Dossier of the Coal Mine is being provided only as a preliminary reference document by 
way of assistance to the Applicants who are expected to carry out their own surveys, investigations 
and other detailed examination of the Coal Mine before submitting their Applications. Nothing 
contained in the Mine Dossier shall be binding on the Nominated Authority nor confer any right on 
the Applicants, and the Nominated Authority shall have no liability whatsoever in relation to or 
arising out of any or all contents of the Mine Dossier. 

 


